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Page Navigation



Page Navigation

• REPORTER now has a Page 

Navigation bar to help you easily 

navigate your report. 

• This bar also allows you to carry out 

the following actions by interacting 

with the page thumbnails: 

• Drag-and-drop to re-order pages.

• Right click to insert page 

after/before, delete a page, and 

duplicate a page.



Blanking in D3PLOT Items



Blanking in D3PLOT Items

• D3PLOT items in REPORTER now have two extra options to 

help provide consistency in captures:

1. Blank the D3PLOT model before reading the properties file.

2. Ignore elements when reading the properties file.

• These options are particularly useful when you want 

consistent captures even if parts/elements are added or 

re-numbered in the model when you reload the capture 

or generate the item.

• These options will be saved to the report or template 

which will ensure consistent captures when it is shared 

with users that have different preferences set.



Blanking in D3PLOT Items

• The D3PLOT pre-blanking option will blank the whole model before the properties file 

is read, preventing any additional parts from showing up in the capture.

Original capture.

 

Capture without the pre-blanking option 
when the item is reloaded/generated with 
the model with additional car door parts.  

Capture with the pre-blanking option when 
the item is reloaded/generated with the 
model with additional car door parts.  



Python API



Python API

• The new Python API will allow you to do most things you can do from the JS API.

• Advantage: the Python scripts run outside the programs: from the same script it is 

possible to speak to PRIMER, D3PLOT, T/HIS and REPORTER, and to any other software 

that has a Python API. It also allows importing any Python module into the script.

• Install the Python modules:

• https://pypi.org/project/Oasys.PRIMER/

• https://pypi.org/project/Oasys.D3PLOT/

• https://pypi.org/project/Oasys.THIS/

• https://pypi.org/project/Oasys.REPORTER/

• https://pypi.org/project/Oasys.gRPC/

• There is a comprehensive Python API documentation to help you start scripting.

https://pypi.org/project/Oasys.PRIMER/
https://pypi.org/project/Oasys.D3PLOT/
https://pypi.org/project/Oasys.THIS/
https://pypi.org/project/Oasys.REPORTER/
https://pypi.org/project/Oasys.gRPC/
https://help.oasys-software.com/articles/?readerUiPreview=1#!py_api-21-0/title
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Workflows User Data

• We have made it easier for you to save Workflows user data to be re-used by multiple models and LS-DYNA runs.

• In Oasys 20, the JSON user data file written by a workflow tool had to be saved in the same folder as the model/results. 

This meant that if you had multiple variations of a model, you had to have copies of the same JSON file in each 

model/results folder, which was time consuming if edits needed to be made to the data.

• In Oasys 21, JSON user data can now also be saved in the parent folders of models, meaning the same data can be used 

for multiple models. The model folder is searched first, and then parent and grandparent folders are searched for valid 

JSON files. Preference oasys*workflow_max_upward_folder_search_depth can be set to control the number of parent 

folders that are searched. The default is 4.

- folder 1
  |- user_data.json
  |
  |- folder 2
  |    |- model1.key
  |    |- user_data.json
  |
  |- folder 3
  |    |- model2.key
  |    
  |- folder 4
  |    |- model3.key

In this folder structure [right], the user_data.json file in folder 1 will be 

used for the models in folder 3 and folder 4, and the user_data.json file in 

folder 2 will be used for the model in folder 2:



Workflows User Data

• The scan will also look for user data in a folder named ‘workflow_user_data’ in the model folder and its parent folders.

• For example, in the folder structure below, the user_data.json file in folder 1/workflow_user_data will be used for the 

models in folder 3 and folder 4, and the user_data.json file in folder 2 will be used for the model in folder 2:

- folder 1
     |- workflow_user_data
  |       | - user_data.json
  |
  |- folder 2
  |    |- model1.key
  |    |- user_data.json
  |
  |- folder 3
  |    |- model2.key
  |    
  |- folder 4
  |    |- model3.key

• The name of the folder to search can be changed by setting the preference oasys*workflow_user_data_directory_name 



Automotive Assessments

In Oasys 21 the assessment 

values and scores are now 

presented in a table making 

it easier to view the results



Far Side + VTC crash test 

• New Far Side + VTC crash test has been added in the Automotive Assessments workflow to 

support Virtual Testing. 

• Includes support for all 115 channels (Occupants + Structures) required for the Euro NCAP 

Virtual Far Side Simulation & Assessment Protocol

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf


Improved entity selection for multiple parts

• To facilitate multiple PARTs selection, new 

options have been added in the Automotive 

Assessments entity selection popup:

1. Select by PART

2. Select by SET_PART

3. Select by INCLUDE 

• In the Far Side + VTC crash test, these options 

are useful for selecting multiple PARTs for 

structural channels like Kinetic Energy, Internal 

Energy, and Hourglass Energy, for Airbag, 

Centre Console, Driver Seat and Dummy.



Updated support for different occupant versions 

• We now support the DYNAmore/PDB WorldSID 50M occupant in versions 4.0, 6.0, 7.6 and 8.0 for left-hand 

and right-hand drive. 

• We have reviewed and corrected various entity IDs and history titles in occupant JSON files that are 

supported in Automotive Assessments workflow. The list of occupant JSON files and corresponding manual 

referenced for checking are listed in this table.

https://help.oasys-software.com/articles/workflows-21-1/automotive-assessments-primer/a/supported_dummies


Euro NCAP Virtual Far Side Validation Criterion 2

• Automotive Assessments can be used to 
check Validation Criterion 2 manually, 
according to Section 6.3 of the Euro NCAP 
Virtual Far Side Simulation & Assessment 
Protocol.

• Validation Criterion 2 check can also be 
automated using Euro NCAP Virtual Far 
Side 2024 VC2 (Assessment Criteria) 
REPORTER template .

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf


New Protocols

• In Oasys 21.1, the following new protocols have been added to the Automotive Assessments 

workflow. Each of these represents a different loadcase required as part of the C-NCAP 

Management Regulation (2024 Edition).

Crash Test Regulation Version Description

Far Side + VTC C-NCAP 2024 (SID2-SBLD) • Front passenger side impact, assessing driver (Far Side 
Occupant) injury. 

• Injury scoring according to Chapter III section 1.2.1.5.3 of  
C-NCAP Management Regulation (2024 Edition) and 
Virtual Testing according to Appendix H.1.2.1.3.

Far Side + VTC C-NCAP 2024 (WSID)

Far Side Pole C-NCAP 2024 (ES-2re+WSID) • Front passenger side impact, assessing driver (Far Side 
Occupant) injury according to Appendix H.1.2.2.2. 

• Injury scoring based on Chapter III section 1.2.1.5.4 of  
C-NCAP Management Regulation (2024 Edition).

Far Side Pole C-NCAP 2024 (WSID+WSID)

Side Pole C-NCAP 2024 (WSID+ES-2re) • Driver side impact assessing driver injury according to 
Appendix D.

• Injury scoring based on Chapter III section 1.2.1.4 of      
C-NCAP Management Regulation (2024 Edition).

Side Pole C-NCAP 2024 (WSID+WSID)



Energy Check

• Previously, the 

Energy Check tool 

simply plotted total, 

kinetic, internal and 

hourglass energy 

for your model. In 

Oasys 21, the tool 

now plots more 

energies, produces 

visual checks, and 

more.



Entities of Interest

• Previously, the Entities of 

Interest tool was able to 

Only, Highlight and 

complete GLB Exports 

for selected entities 

grouped by Parts or Part 

Sets. In Oasys 21, you 

can now Zoom In, Colour 

By and produce Mixed-

Mode Plots grouped by 

Parts, Parts by Set, Parts 

by Include and Parts by 

Group.

The image shown is an SI Mixed-

Mode Plot on the Footwell and 

Coloured by Magenta on the 

Steering Wheel



Seismic Workflows

Oasys 21 features new tools to power two of the most common seismic analysis workflows:

Storey Drift

In PRIMER, define drift nodes at different 

locations, for each storey.

In T/HIS, storey drifts are plotted for each 

location defined.

Storey Force

In PRIMER, define DATABASE_CROSS_SECTIONs 

for selected structural members grouped into 

SET_PARTs, for each storey.

In T/HIS, storey section forces are extracted for 

the cross-sections defined.

The Workflows can process 

a single model or a sweep 

of LS-DYNA runs for a set 

of ground motions.



Seismic Workflows

You can also generate automated reports with the REPORTER templates provided:



Defined and Undefined Workflows

The Workflows menu has been split into two tabs:

• Defined Workflows – shows workflows that can be run in T/HIS and have the required data  

• Undefined Workflows – shows workflows that could be run in T/HIS, but don’t have the require data



Defined and Undefined Workflows

Selecting a workflow in the 

Undefined Workflows tab will 

open the model in PRIMER and 

start the workflow to select the 

required data. 

In T/HIS, a window will open 

telling you to press Refresh 

when the data has been saved. 

This will update the Workflows 

menu, moving the workflow to 

the Defined Workflows tab so 

it can be run in T/HIS.



Virtual Testing



Virtual Testing

At Oasys Ltd., we are working on software features to support the upcoming Virtual Testing 

Crashworthiness protocols. The first protocols to be introduced are the Euro NCAP Virtual Far 

Side Simulation & Assessment Protocol, and C-NCAP Management Regulation (2024 Edition), with 

others to follow soon.

Oasys 21 contains a set of integrated and complementary Workflow tools to power your Virtual 

Testing CAE workflows:

• Automotive Assessments (now supports the Euro NCAP and C-NCAP virtual testing protocols)

• LS-DYNA to ISO-MME

• SimVT

• VTC Quality Criteria

• VTC Videos

https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://cdn.euroncap.com/media/77313/euro-ncap-vtc-simulation-and-assessment-protocol-v10.pdf
https://www.c-ncap.org.cn/article-detail/1760235142548373506


Virtual Testing

Virtual Testing presents several challenges for CAE workflows:

Q1. Good correlation is moving from beneficial to mandatory. As CAE teams, we can no longer rely on conservative assumptions. How do we 

ensure that physical tests perform as predicted?

A1. SimVT is a powerful new tool for correlation analysis, providing flexibility, and the ability to interrogate correlation results in detail, to help you 

understand your models’ accuracy, robustness, and sensitivity.

Q2. How do we ensure that the format and quality of information is sufficient when submitting results to Euro NCAP? How to avoid rework and 

resubmission?

A2. Use the VTC Quality Criteria tools to ensure your models meet the required standard. Use the VTC Videos tools to provide the video evidence required. 

Use the LS-DYNA to ISO-MME tool to export your results data in the required format.

Q3. CAE teams will need to work more with physical test data, and safety teams will need to work more with simulation. We will also be dealing 

with more metrics than ever before. How do we improve collaboration and processing?

A3. The LS-DYNA to ISO-MME tool provides seamless transition between simulation and test formats. SimVT supports test data stored in ISO-MME format 

as well as a configurable CSV format.

Q4. How can we manage the large volume of data and processing required for Virtual Testing?

A.4 SimVT helps you summarise the correlation analysis results for all the occupant and structures data channels, as well as providing the ability to sift 

through the data in more detail. Other tools include REPORTER templates to automate the processing of data. Results tables, graphs and scores can be 

exported in various formats to link with your team’s data management tools and processes.



Virtual Testing

• All the new Virtual Testing tools can be 

accessed from the Tools → Workflows 

menus in PRIMER, D3PLOT and T/HIS by 

filtering for Virtual Testing.

• REPORTER templates can be found at

File → Open Library Template… by 

selecting the Automotive tab and filtering 

for Virtual testing. 



LS-DYNA to ISO-MME

• “LS-DYNA to ISO-MME” is a new Workflow tool to convert LS-DYNA results into the ISO-MME format 

specified by the Euro NCAP Virtual Far Side protocol. It can also be used to export the channels required by 

the C-NCAP Far Side Occupant Protection Protocol.

• Automotive Assessments workflow user data removes the need to manually map LS-DYNA entities to ISO-

MME channel codes.

1. In PRIMER, populate all the fields 

required by the Euro NCAP or C-NCAP 

protocol. Contact data and Distance 

between head CoG and excursion lines 

can be populated automatically. When 

you save these, you can reuse the settings 

for subsequent LS-DYNA runs.

2. In T/HIS, perform the export to ISO-MME 

format. Solver and simulation information 

can also be populated automatically.



LS-DYNA to ISO-MME

• The LS-DYNA to ISO-MME Workflow can be automated using the REPORTER template 

provided. The report generated contains a summary of the ISO-MME file information 

and individual channel graphs, as well as highlighting any missing data for correction.



SimVT

• SimVT is a powerful interactive tool for correlating simulation data vs test, or indeed any 

combination of: LS-DYNA models, ISO-MME data or CSV data.

• SimVT supports the Euro NCAP and C-NCAP Virtual Testing protocols and can be used to 

identify sensors that fail to pass Validation Criterion 1 or correlation fitting index 

requirements.

Map LS-DYNA entities to 
test data channels using 
Automotive Assessments

Confirm setup Investigate results

The SimVT Workflow

Correlate Export



SimVT

• SimVT seamlessly aligns simulation curves 

to tests using ISO-MME Channel Codes.

• You can create custom rules for pairing 

approximate matches.

• Hundreds of correlations are achievable 

with a single click.

• Results are displayed in a table and can be 

exported to CSV.

• Graphs of all correlations can be easily 

plotted and navigated.

• Settings files can be saved to restore 

previous sessions.



Euro NCAP Virtual Far Side Validation Criterion 2

• The Euro NCAP Virtual Far Side 2024 VC2 

(Assessment Criteria) REPORTER Template can 

be used to perform the Validation Criterion 2 

(Assessment Criteria) check according to section 

6.3.10 of the Euro NCAP VTC Simulation and 

Assessment Protocol v1.0. 

• Before running the template, you need to set 

up user data in PRIMER’s Automotive 

Assessments Workflow using the Euro NCAP 

‘Far Side + VTC’ protocol.

• You can also perform VC2 manually in T/HIS.



C-NCAP Management Regulation (2024 Edition)

Oasys 21.1 has new support for the various requirements of 

the C-NCAP Far Side Occupant Protection Protocol, including:

• For each of the eight Working Conditions:

• Occupant injury assessment

• ISO Correlation Fitting indices

• Correction Factor A

• Dual-Occupant Penalty calculation

• ISO correlation fitting indices for the Virtual Assessment 

Certificate (prerequisite for the symmetry of far side 

occupant protection airbags)

• Overall score calculation

Read the documentation to learn more

https://help.oasys-software.com/articles/workflows-21-1/cncap-management-regulation-2024-edition


Euro NCAP VTC Quality Criteria

• “Euro NCAP VTC Quality Criteria” is a new, convenient tool for assessing the quality 

criteria specified in section 6.1 of the Euro NCAP Virtual Far Side protocol.

1. In PRIMER, select the model entities 

required for the quality checks, and 

the relevant model and display units. 

Saved user data can be reused for 

subsequent LS-DYNA runs.

2. In T/HIS, the quality checks are 

calculated immediately. Graphs 

illustrate the results of each check. A 

summary table appears, with the 

option to write the results to a CSV 

file.



Euro NCAP VTC Quality Criteria

• The Euro NCAP VTC Quality Criteria Workflow tool can be automated using the REPORTER 

template provided.



C-NCAP VTC Quality Criteria

• The C-NCAP VTC Quality Criteria Workflow tool follows the same principals as the Euro NCAP 

version but assesses the quality criteria specified in section H.1.1(f) of the C-NCAP Far Side 

Simulation & Assessment Protocol.

• The tool can be automated using the REPORTER template provided.



Euro NCAP VTC Videos

• The Euro NCAP VTC Videos Workflow tool helps you calculate the views and export the videos 

specified in section 5.2.1 of the Euro NCAP Virtual Far Side protocol.

• The tool attempts to calculate the 

camera positions automatically 

based on model entities you 

define in PRIMER. You can then 

adjust and save the views in 

D3PLOT to be reused to capture 

the videos for future LS-DYNA 

runs. The whole process can be 

automated using the REPORTER 

template provided.



C-NCAP VTC Videos

• The C-NCAP VTC Videos Workflow tool follows the same principles as the Euro NCAP version 

but helps you calculate the views and export the videos specified in section H.2.8 of the C-NCAP 

Far Side Occupant Protection Protocol (2024 Edition).

• Use the standard Workflow 

method in PRIMER and 

D3PLOT or the whole process 

can be automated using the 

REPORTER template provided.



Automotive Library Templates



Migration to Workflows

The following Automotive templates have been migrated to use data saved from the Automotive 

Assessments Workflow:

• IIHS_Front_SOB_Impact_2021 (new in v21.1)

• IIHS_Front_SOB_Impact_2021_StructureOnly (new in v21.1)

• IIHS_Side_MDB_Impact_2021 (new in v21.1)

• IIHS_Side_MDB_Impact_2021_StructureOnly (new in v21.1)

• USNCAP_Front_FFB_Impact_2015 (new in v21.1)

• USNCAP_Side_MDB_Impact_2015 (new in v21.1)

• USNCAP_Side_Pole_Impact_2015 (new in v21.1)

• EuroNCAP_Front_FFB_Impact_2017

• EuroNCAP_Front_MPDB_Impact_2020_Occupant_Assessment

• EuroNCAP_Front_ODB_Impact_2017

• EuroNCAP_Side_MDB_Impact_2022

• EuroNCAP_Side_Pole_Impact_2022

• CNCAP_Front_MPDB_Impact_2022_Occupant_Assessment

• IIHS_Front_ODB_Impact_2021 (new in v21.1)

• IIHS_Front_ODB_Impact_2021_StructureOnly (new in v21.1)



Migration to Workflows

To use the new templates you need 

to specify and save the required data 

from the Automotive Assessments 

Workflow in PRIMER

In REPORTER the templates can be run 

from File -> Open Library Templates. 

The new templates that use Workflow 

data are indicated by the          icon.



Migration to Workflows

Migrating the templates to use data saved from the Automotive Assessment Workflow 

has the following benefits:

• Setting up the data and generating the templates is simpler with fewer steps required

• The same data can be used in in the Automotive Assessment workflow in T/HIS to 

interactively plot and interrogate results

• It makes it easier to add templates for new protocol versions and protocols not currently 

supported



Eigout Table

Extract eigenvalues (modal frequencies) from LS-DYNA’s eigout file



Eigout Table

A new script has been added for Library Program items to extract eigenvalues (modal 

frequencies) from LS-DYNA's eigout file. The script creates REPORTER variables, 

allowing the eigout results to be tabulated in a report. The following library templates 

and pages are now provided:

• Eigout Table (A4 Portrait Layout)

• Eigout Table (PowerPoint Layout)

Mode Eigenvalue Frequency (rad) Frequency (Hz) Period (s)

1 71889.1 268.12 42.67 0.0234

2 88703.7 297.83 47.40 0.0211

3 102198.0 319.68 50.88 0.0197

4 109448.3 330.83 52.65 0.0190

5 112211.7 334.98 53.31 0.0188

6 113456.6 336.83 53.61 0.0187

7 113688.1 337.18 53.66 0.0186

8 116641.0 341.53 54.36 0.0184

9 125036.7 353.61 56.28 0.0178

10 125326.4 354.01 56.34 0.0177

11 166304.4 407.80 64.90 0.0154

12 181088.1 425.54 67.73 0.0148

13 189493.3 435.31 69.28 0.0144

14 196922.2 443.76 70.63 0.0142

15 208863.8 457.02 72.74 0.0137

16 209988.9 458.25 72.93 0.0137

17 210390.3 458.68 73.00 0.0137

18 211030.8 459.38 73.11 0.0137

19 213627.6 462.20 73.56 0.0136

20 221216.5 470.34 74.86 0.0134



REPORTER Variables



Default names for REPORTER variables

• Before Oasys 21, the default names for variables created by D3PLOT and T/HIS items 

were prefixed with ITEM_n, where n was the number of the item on the page in the 

D3PLOT or T/HIS item tree. Because items in the item tree are numbered from 1 on 

each page, it was common to have the same prefix for default variable names on 

multiple pages and therefore to have identical default variable names for items on 

multiple pages, resulting in variables being overwritten in REPORTER.

• In Oasys 21, default variable names are prefixed with the REPORTER item name, 

which defaults to a format like “d3plot6”, “d3plot6_1” for D3PLOT items (or “this6”, 

“this6_1” for T/HIS items). Since item names in REPORTER are unique, this ensures 

default variable names generated in D3PLOT and T/HIS are also unique.



Preferences



Libraries and Workflows

You can now define a single 

location for each of Libraries 

and Workflows. This allows you 

to switch REPORTER to use a 

different directory when you 

customise the templates 

provided with the installation, 

or when you receive an 

updated bundle of templates 

from Oasys Ltd.



New Preferences

Preference Description

oasys*workflow_only_use_specified_directory Only scan location set by preference 
oasys*workflow_definitions_directory for Workflow definitions.

oasys*workflow_user_data_directory Name of a folder to search in for workflow user data

oasys*workflow_max_upward_folder_search_depth Maximum number of folders to search up to look for workflow 
user data

oasys*initial_view_orientation Initial view orientation for the graphics window

reporter*library_only_use_specified_directory Only scan location set by preference reporter*library_directory 
for Library templates, pages and scripts.



Contact Information

UK

T: +44 121 213 3399

dyna.support@arup.com 

For more information please contact us:

www.arup.com/dyna

China

T: +86 21 3118 8875

china.support@arup.com 

India

T: +91 40 69019723 / 98 

india.support@arup.com 

USA West

T: +1 415 940 0959

us.support@arup.com 

or your local Oasys distributor 

mailto:dyna.support@arup.com
mailto:china.support@arup.com
mailto:india.support@arup.com
mailto:us.support@arup.com
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